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OFFICE PRODUCTIVITY TOOLS

Part II

5.1 INTRODUCTION

Two of the productivity tools viz. word processing and spreadsheet
have already been discussed earlier. In this lesson we will  dicuss
remaining tools viz., database management and presentation.

One of the most powerful applications of computers is its
capability to store, organize, and retrieve large quantities of data.
An organized collection of related data is referred to as a database.
A database is a collection of objects that allow you to store data,
organize and retrieve it in any way you want.

After having a pool of useful information, may be in the form of a
document, spreadsheet, database or any other form, it is required
to present it before audience in a most effective manner. For this
purpose a very powerful presentation tool in the form of Microsoft
PowerPoint 2007, has been discussed.

This package is a complete presentation tool which will present
you ideas in a simple, concise and interesting manner. Even if you
are not multimedia expert, this tool helps you create slides and
present exciting slide shows.

5
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5.2 OBJECTIVES

After going through this lesson you would be able to:
 explain the terms like database, table, record, field, datatype;

 create a database from scratch or using template;

 create tables for data entry in datasheet view and design view;

 create queries using wizard and design view;

 create a Form using various tools;

 create report in different ways;

 create presentations using different types of slides;

 add various multimedia features to slide;

 save and print a database, query reports, and presentation

5.3 STARTING ACCESS PROGRAM

You can start your Access program in different ways.  One way is
using Start button:

1. Click on the Start button.
2. In the menu that appears select All ProgramsMicrosoft

Office Microsoft Office Access 2007 (Fig. 5.1).

Fig 5.1

In few seconds you will see Getting Started with Microsoft Office
Access screen on the monitor (Fig. 5.2).
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You have the following three options:
(i) Open a Blank Database
(ii) Open a Microsoft template
(iii) Open a Recent Database

Fig 5.2

5.3.1 Creating a Database from the scratch
Choose the option Open a Blank Database for creating a Database
from the scratch.
1. Blank database with the default name Database1 appears

as shown in Fig. 5.3.

           Fig 5.3                       Fig 5.4

Select a
template
category

Open an
existing
databaseSelect a

template

Create a blank database
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2. Type the file name of the database e.g. NIOS_dbase (Fig 5.4).

(It is recommended to create a general database before
creating tables and forms.)

3. Browse and select folder

4. Click Create.

Your database file NIOS_dbase is saved in the specified folder
and opens for you to create an Access table in datasheet view
(Fig 5.5).

Fig 5.5

5.3.2 Creating a Database using Template

You can create a database by using Template in following ways:

(i) Select suitable Featured Online Templates from the
relevant Template Category as shown earlier in Fig. 5.2.

(ii) In the Ribbon click Create tab as shown in Fig. 5.6 (a)and
in the Tables group bring cursor at Table Templates (Fig.
5.6(b)) and click it. Then select and click the desired
Template from the drop down list of template as shown in
Fig. 5.6 (c) and the template opens as shown in Fig. 5.6(d).
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   (a) (b)             (c)

(d)
Fig 5.6

5.3.3 To Open an Existing Database
Click a database in the Open Recent Database list as shown
earlier in Fig. 5.2 or click More and browse for the desired
database.

5.4 HOW ACCESS STORES DATA IN TABLES
Access 2007 stores data in tables which look more like the cells
of a spreadsheet with columns and rows. Each row represents
a record, and each column represents a field. Table 5.1 is an
example of a Table having Details of Students. In this Students
database  each student would be considered as a record and
each record (student) consists of headings or categories called
fields or attributes, and each record in the database is
formatted in the same way.

Table 5.1: Details of Students

    

Enrolment 
No. 

First 
Name 

Surname Mother’s Name Gender Date of 
Birth 

City 

1 Sohan Verma Rama Devi Male 15/01/1992 Patna 

2 Mohan Nath Veena Rani Male 10/11/1991 Gwalior 

3 Meghna Kishore Deepa Kishore Female 28/02/1990 Agra 

4 Ashita Agrawal Abha Agrawal Female 26/03/1993 New Delhi 

5 Rohit Goel Kavita Goel Male 10/07/1992 Mysore 

6 Anshul Agrawal Hansi Agrawal Male 26/11/1995 Gwalior 
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5.5 ENTER DATA INTO A TABLE

Once a table has been created, data can be entered.
1. If your new table is not open, double click on its title, in the

Navigation Pane.
2. In the Home tabViews group, select Datasheet View.

(The default view for a new table is Datasheet view.)
3. The first field (column) is automatically named ID, the data

type is AutoNumber and it is the assigned Primary Key.
Generally Primary keys are not required but they are
needed to combine two or more tables, columns, or rows
in a database. Primary key is a unique number, i.e., it
cannot be duplicated.

4. Double click on Add New Field and type in the new field
name F_name for the First Name, L_name for Last name
of the student and so on as given in Table 5.1. When
entering field names, do not use spaces or punctuation.

5. Type in Sohan, in the first row under the field F_name.
6. The Data Type is set to Text. While entering numbers or

date, the data type would be set to Number or Date and
Time and so on.

Complete the table by entering data (as given in Table 5.1). The
screen will look like Fig 5.7.

Fig. 5.7
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5.5.1 Data Types

It is important to assign appropriate data types as given in Table
5.2 to a field since they specify what type of data can be entered
into a field.

Table 5.2

IN TEXT QUESTIONS 5.1

1. State True or False.

(a) A database is an organized collection of records.

(b) A database can hold only one Table.

(c) A particular field has same Data type for all the
records in a table.

Data Type Description 

Text Can contain text, numbers, or a combination that do not 
require calculations such as addresses, phone numbers, 
etc. Maximum number of characters, including spaces, 
is 255 characters. 

Memo Similar to the text field but can hold huge data. 

Number Can have Numeric data only 

Date/Time Date and Time information 

Currency Currency up to precisely  4 decimal places 

AutoNumber  Use when sequential, random, or replication ID num-
bers are needed. Access creates a unique number for 
each new record.  This is often the primary key for the 
table. 

Yes/No Use when Yes/No, True/False, or On/Off are necessary. 

OLE Object Add objects such as Excel workbooks or Word docu-
ments that are linked or embedded. 

Hyperlink Link to files, objects or web links.  

Attachment Attachments such as images, spreadsheets, documents, 
and charts. 
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(d) Data type Number can have the data Rohan.

(e) Primary key for three records in a Table has same
data.

2. Fill in the Blanks.

(a) Vertical column in a table is known as ………… .

(b) No two records in a Table can have same data for
…………  …….. .

3. Which of the following Data type can have ONLY one of the
two fixed values?

(a) AutoNumber

(b) Number

(c) Yes/No

(d) Date/Time

4. Which of the following Data type can be assigned to a
Primary key?

(a) AutoNumber

(b) Memo

(c) Yes/No

(d) Text

5.6  SAVE A TABLE

Saving a table with a specific title will help when organizing
information, creating queries, forms, and pages, and connecting
to other tables.

1. To save the current table, click the Save button in the Quick
Access Toolbar.

2. You can also get to a Save button through the Office
Button.

3. You can use Save As, from the Office Button to rename
the database, save a copy or to save it in another format.
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5.7  CHANGE VIEWS

A view is a way of looking the data stored in tables. Two possible
ways for viewing the data are Datasheet view and Design view.
View buttons are provided in the lower right corner of the Access
window which help you to switch from one view to other. You can
also use view buttons on the Home tab to change views.

5.7.1 Adding Fields in Datasheet View

By default, Access 2007 creates one field in each new table, the
ID field. This field auto-numbers to give each record in the table
a unique number identifier. Recall that records are the rows in a
table.

To add more fields to a table in Datasheet View, double click
on the Add New Field header. The Add New Field text will
disappear from the header. Name the field by typing the name
directly into the header. Press the tab key on your keyboard to
move to the next field.

5.7.2 Adding Fields in Design View

In Design View, the field names are along the left-hand column
instead of across the top like in Datasheet View.

Creating or editing a table in Design View gives you freedom to
construct a table with specifications for data collection. You do
not type in the actual data in this screen.You are setting up the
table structure - field names, data types, field size, etc.

To add a new field to a table in Design View, just click in the
cell where you want the new field and type the field name. When
you switch back to Datasheet View, your new field appears as its
own column.

In Design View, you have many field property options that you
can set to ensure that data can only be entered in certain formats.
Setting these options is a good idea if you want to make sure the
data that you have in your database is correct in all respect.

5.8 CHANGING COLUMN WIDTH

When you create a table from scratch in the Datasheet View,
Microsoft Access assigns it a default width. That width may
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appear to be too narrow or too wide to accommodate data. You
can widen or narrow a column in many ways.

To change the width of a column position, place the mouse on
the right border of a column header. The mouse pointer would
change into a horizontal double arrow crossed by a vertical line

. Drag in the desired direction, left or right until you get the
desired width. If you double-click, the column would be resized
to the maximum width of the column.

5.8.1 Inserting a Column/ Field

Inserting a column consists of adding one between two existing
fields. You can do it in any of the following ways:

 To insert a column using the Ribbon, first click a cell under
the column that will succeed it. Then, in the Fields &
Columns section of the Datasheet tab, click the Insert
button 

 To insert a column from the table, right-click the column
that will succeed it and click Insert Column.

 To insert a field from the Field Templates, click and drag
it from the Field Templates and drop it to the left of the
column that will succeed it.

 To insert a field in Design View, select the field before
which a field is to be inserted, click the Design tab on the
Ribbon and then the Tools group click Add rows. A blank
field will be inserted.

5.8.2 Moving Fields
If you want to rearrange the order in which your fields appear in
a table, Access 2007 lets you easily move them around. To move
a field in Datasheet View, drag and drop the field to the location
you want. To do this:
 Click on the field header for the field you wish to move.
 Move the mouse in the area of the header.
 When the cross with arrows appears, hold down your left

mouse button.
 With the left mouse button still held down, move the cursor

to where you would like the field to appear.
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 Release the mouse button and the field appears in its new
location.

5.8.3 Deleting Fields
To delete a field in Datasheet View, just click on the field header
and then select Delete from the Field & Column command group.
This is found on the Datasheet tab on the Ribbon.
To delete a field in Design View, select the field to be deleted,
click the Design tab on the Ribbon and then in the Tools group
click Delete rows.

5.9. MODIFYING A TABLE IN DESIGN VIEW

If you print the table which is shown in fig. 5.7 as it is, it is not
clear what F_name or M_name stands for. Is it first name and
middle name or father’s name and mother’s name?  Similarly we
see that Gender is having only two values. Either it is male or
female. Therefore, in order to give suitable table headings or
changing the data type, you can edit the table which is done in
Design view.

If you need to change data types, click on the down arrow in the
box next to Data Type to make your selection.

1. The default view for a new table is Datasheet view. In the
Home tab Views group, select the Design View button to
switch to Design View.

2. To add or edit fields, type in the Field Name column. When
entering field names, do not use spaces or punctuation.

3. You can set more specific settings for your data types in
Design View. For example, select the field ID, locate the
General tab and label the Caption as Enrolment No.

4. Similarly type a label for the Captions e.g. First Name, Last
Name and Mother’s Name for fields F_name, L_name and
M_name and the set the Field Size as 30, 20 and 40
respectively. The field size indicates that the data cannot
exceed the specified limit.

5. Select the field Gender and under Data Type, click on the
down arrow and select an appropriate data type Yes/No
(Fig. 5.8) and in General Tab for caption type Female?
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Fig. 5.8

Edit the field DOB with the caption as Date of Birth and the Date
Format from Short Date to Medium Date (Fig. 5.9).
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Fig. 5.9

Now your Students table will look as shown in Figure 5.10.

Fig 5.10
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5.10 TO RENAME A TABLE

With the table closed, right click on the Table you wish to rename
in the Navigation Pane. Select the Rename option that appears
in the menu.

The table name will be highlighted and a cursor will appear, which
means you can now type in the new name. Left click anywhere
outside of the Table name to make the change.

5.11 CLOSE A DATABASE AND EXIT ACCESS

The following points describe how you close a database and exit
Access.

5.11.1 To close a database

1. Click the Microsoft Office button. A menu appears.

2. Click Close Database. Access closes the database.

5.11.2 To exit Access

1. Click the Microsoft Office button. A menu appears.

2. Click Exit Access. You exit Access

IN TEXT QUESTIONS 5.2

5. State True or False.

(a) By default Access 2007 opens two tables.

(b) Field properties are available in Design view.

(c) Drag and drop is not used to move fields.

(d) If a data in a cell is changed then it is updated in all
the objects of that database.

6. Fill in the Blanks.

(a) Commonly there are  ………… views used for viewing
a table data.

(b) Generally the table is edited in ……….. View.
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5.12 CREATING QUERIES
Access 2007 has a powerful feature of queries. Queries actually
mean the question you asked from the database to get the
desired result. A query can be designed to extract data from one
or more database tables. Queries in Access can be created in
various ways and range from very simple field selection to
complex conditional statements or calculations.

Access 2007 allows you to create queries in two ways.

(1) Using the query wizard

(2) Using design view.

5.12.1 Creating a simple query using the query wizard
When you use this method for creating query, the query wizard
guides you through a series of dialogue boxes and you can
proceed by selecting various options. The steps are given as
follows:

1. Click create tab

2. In the other group, click on the query wizard (Fig 5.11).

3. When new query dialogue box appears, Select simple
query wizard and click OK (Fig 5.12).

Fig 5.11

Fig 5.12
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4. A simple query wizard dialogue box appears. From the
Tables/Queries list box, select the table on which you want
to create the simple query. Here we have selected the table
named Friends of Mine (Fig 5.13).

5. All the fields of selected table are shown in the available
field’s area. Select the field you want to add in your query
and then click on the > button. If you want to select all the
fields than you can click on >> button. (See fig 5.13)

  Fig 5.13       Fig 5.14

6. In Fig 5.14, it has
been shown how to
select one field from
the available field’s
area and move it to
the selected field’s
area. In this case we
have selected 3
fields, first name,
last name and
phone number.

7. Click on the next
button. Next screen
appears as shown in
Fig 5.15.

8. Type a title for your query in the box provided as shown in
Fig 5.15. Here title for the query is Names and numbers.

Fig 5.15
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9. Click on the finish button.

10. Access 2007 displays the result of query in the form of a
table as shown in Fig 5.16. Since we have asked only for 3
fields, First name, last name and the phone number to be
shown from the table Friends of Mine, only these 3 fields
are displayed as you can see in Fig 5.16. This is a simple
query.

Fig 5.16

5.12.2 Creating Query Using Design View

A query can also be created using Design View in which you can
define the structure of query. To create a query, you open
the tables on which you are going to base your query in Query
Design view, and then use the options to create your query. Click
the Run button to display the results. Queries can be saved for
later use also. The steps are as follows:

1. Click the Create tab.
2. Click the Query Design button in the other group. The

Show Table dialog box appears (Fig. 5.17).
3. Click on the tables tab. A list of tables appears.
4. Double Click to choose the table on which you want to base

your query. Here student_pers table has been selected (Fig
5.17). (You can select more than one table also).

5. Click Add. The table appears in the window.
6. Click Close to close the show table box. Access changes

to Query Design view. If you select more than one table, you
have to show relationship between them through Primary
key.
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Fig 5.17

To Show a single column:

1. Click on the field name you want to display. (In this case it
is student name field of student_pers table).

2. Drag it in the field line or you can double click on the field
to bring it to the field line (Fig. 5.18).

3. Click the Run button. Access shows the column you chose
(Fig. 5.19).

Fig 5.18                 Fig 5.19

Showing Multiple Columns

You can use an Access query to show multiple columns of data.
On the Field line in Query Design view, choose the field name
of each field you want to show in the same order as you want to
display them in the query. The steps are as follows:
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1. As the students table is already selected you can select the
field from the given list.

2. Click on the field names you want to show one by one in
the order you want to display them. For example you can
place roll no field before the student name field in the
field’s grid area (Fig 5.20).

Fig 5.20

3. Click the Run button. Access displays the columns you
chose (Fig 5.21).

Fig 5.21
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5.13  SORT A QUERY
When creating a query, you can sort the columns in ascending
or descending order by choosing the option you want on the Sort
row in Query Design view. The steps are as follows:
1. Open the student_pers table in the design view
2. Select and drag the fields in the field grid area in the order

you want them to be displayed.
3. Click in the sort row in the column  which you want to sort

(in this case it is the  State column) and Click the down
pointing arrow that appears and then choose ascending (or
descending)from the drop down list (Fig 5.22).

4. Click Run button.
5. The sorted column is shown along with others in the Fig 5.23.

Fig 5.22

Fig 5.23
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5.14 EXTRACTING RECORDS USING CRITERIA
STATEMENTS

Adding a criteria statement to the query design grid will help you
to extract only those records which match the given criteria and
which you want to display from the complete table.

You can use logical operators such as = (equal), <> (not equal), >
(greater than), or < (less than) to restrict the records you retrieve.
For example, if you only want to display friends who live in DELHI,
enter = “DELHI” in the State column on the Criteria line. Access
will only retrieve records where the value in the State column is equal
to DELHI. Selection criteria are not case-sensitive, so Access will
retrieve records where the entry is DELHI, delhi, Delhi, or dELHI.

The list of logical operators which you can use in making criteria
statements in making your query is given in the table 5.3.

TABLE 5.3

Logical Operators 

Operator Meaning Field Type Entry Format 

= Equal to Character 
Number 
Date 

= "DELHI" 
= 5 
= #12/16/98# 

<> Not equal to Character 
Number 
Date 

<> "DELHI" 
<> 5 
<> #2/16/97# 

> Greater than Character 
Number 
Date 

> "DELHI" 
> 5 
> #7/16/98# 

>= Greater than or equal to Character 
Number 
Date 

> = "DELHI" 
> = 5 
> = #6/21/96# 

< Less than Character 
Number 
Date 

< "DELHI" 
< 5 
< #4/18/98# 

<= Less than or equal to Character 
Number 
Date 

<= "DELHI" 
<= 5 
<= #11/19/98# 

In Equal to any item in a list Character 
Number 
Date 

In ("DELHI", "UP") 
In (5, 9, 17) 
In (#2/11/99#, #2/3/96#, 
#12/15/98#) 

Not In Not equal to any item in a 
list 

Character 
Number 
Date 

Not In ("DELHI", "UP") 
Not In (5, 9, 17) 
Not In (#2/17/97#, 
#2/3/96#, #12/15/98#) 

Between Between two values,  
greater than or equal to 
one and less than or equal 
to the other 

Character 
Number 
Date 

Between "C" And "F" 
Between 5 And 10 
Between #1/1/98# And 
#12/31/99# 
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To retrieve specific records, the steps are as follows:
1. Open a table or query in Query Design view.
2. Choose the field names you want to display in the order you

want to show them.

3. Choose the field names you want to sort by in the order you
want to sort.

4. Under the fields you want to sort by, choose Ascending or
Descending.

5. Deselect the Show button for columns you do not want to
display.

6. Enter your selection criteria on the Criteria line (Here
the criteria entered in the state column is = “DELHI”) (Fig
5.24).

7. Click the Run button. The query results can be viewed in
the Fig 5.25.

Fig 5.24
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Fig 5.25

Adding Multiple Criteria

You can apply multiple criteria to the same table. If you place two
criteria on the same line, Access will only retrieve records where
both criteria are met. For example, if you want all records where
the State is equal to “UP” and the CITY is equal to GHAZIABAD,
you would set the State field to = “UP” and the CITY field to =
“GHAZIABAD” and you would place both criteria on the same
line.

The steps for using and criteria are shown in Fig 5.26 and result
is shown in Fig 5.27.

If you place one set of criteria on the Criteria line and the second
set of criteria on the Or line, Access will retrieve records where
either of the two criteria is satisfied. You can add additional and
and or statements by using the lines below the Or line. For And
clauses, place the criteria on the same line; for Or clauses, place
the criteria on separate lines.
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Fig 5.26

Fig 5.27

5.15 SAVE A QUERY

After you create a query, you can save it. You can re-run a saved
query at any time. If you change the data on which the saved
query is based, you will see the changes when you re-run the
query. The steps are as follows:

1. Click the Save button on the Quick Access toolbar. The
Save As dialog box
appears.

2. Type the name you
want to give to your
query.

3. Click OK. Access saves
the query. (Fig 5.28)

Fig 5.28
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4. Alternately you can also save by right-clicking a query’s tab
and then selecting save from the menu that appears.

5. Once you have saved a query, you can run it by opening
the Navigation pane and then clicking the name of the
query.

INTEXT QUESTIONS 5.3

7. Fill in the blanks.

a) Simple query wizard option is available in the———
— dialogue box.

b) Access 2007 displays the result of query in the form
of a —————————.

c) Queries can be created using the Query Wizard or the
————————view.

d) In order to see the result of query in design view, you
have to click on the ————button.

e) —————operators are used to extract specific
records which meet the given criteria.

8. Write TRUE or FALSE.

a) While sorting the records two options available are
Up and Down.

b) A query is saved with a name.

c) Queries actually mean the questions you ask from
the database to get the required result.

d) You cannot run a saved query at any given time.

e) To show the result of query, click on the “Final”
button.
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5.16 FORMS

A form is a graphical representation of a table. One can add,
update and delete records in table by using a form. A form is very
useful to use when the table contains numerous fields. Forms
make it easy for you to access information in a database. With a
form, you can focus on one record in a database at a time and
can view, add and delete data from that record.

5.16.1 Creating a Form using the Form Tool

Form tool in access 2007 can be used to create a form with a
single mouse- click. To create a form with this tool, steps are as
follows:

1. In the Navigation Pane, select the table or query to create
a form.

2. Click on the create tab

3. In the forms group, click form (Fig. 5.29)

4. Form is created displaying it in layout view along with the
form layout tools i.e. Format tab in the ribbon. (Fig 5.30)

Fig 5.29

5.16.2 Creating a Form
using Form Wizard

1. Click the create tab

2. In the forms group, click
more forms (Fig. 5.31)

Fig 5.30
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Fig 5.31

3. When you click form wizard, a Form wizard dialog box
appears. (Fig 5.32)

4. From the available fields area, select the fields one by one
which you want in your form.  Click  > button. To select all
fields click on >> button.

Fig 5.32
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5. Now click Next button (Fig. 5.32)

6. Select a layout for the form. The various layout for forms
available are columnar, tabular, datasheet and justified
and click Next button (fig. 5.33).

Fig 5.33

7. Choose a style you want for the form (Fig. 5.34) and click
Next button.

Fig 5.34

8. Provide a title for the form. (Fig. 5.35) and click Finish
button.
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Fig 5.35

The form will open in Form View (Fig. 5.36)

Fig 5.36

5.17 REPORTS
Although tables, queries and form can be printed, they may not
look very professional, as they are not designed for printing
purposes. Reports, however, are designed to take the data from
a table or selected by a query and printed in a professional looking
layout. Report allows you to group, sort and manipulate the data
to suit your requirements. Reports are the most powerful and
flexible way to view and print the information in your database.
To make your data more presentable for others to record and
easily understand, you would need to create reports.
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5.17.1 Creating a Report using Report Tool
The Report tool in Access 2007 helps you to create a report very
fast. Steps are as follows:

1. In the Navigation Pane, click the table or query for which
you want to make a report.

Fig 5.37

2. Click the create tab, in the Reports group, click Report.
(Fig 5.37)

3. Report is generated and displayed in layout view along with
the Report Layout Tools i.e. Format Tab in the ribbon (Fig
5.38).

Fig 5.38
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Fig 5.40

5.17.2 Creating a Report Using Report Wizard

Report Wizard can be used to include the selected fields in your
report and specify how the data is grouped and sorted. Fields from
more than one table or query, can also be used if you have
already specified the relationship between the tables and
queries.

Various steps are as follows:

1. Click the Create Tab,
in the forms group,
click Report wizard
button. A Report
Wizard dialog box
appears (Fig. 5.39).

2. Click in the Tables/
Queries list box and
choose the table or
query name that
contains the data to
be included in a
report.

3. From Available Fields: area, select the fields which you
want in your report and click > button. To select all the
fields present in the Available Fields: area, click >> button.
To remove a field from the Selected Fields: area click the
< button. To remove all the fields, click the << button. Click
Next button.

4. Additional dialog box
appears, asking for
grouping your data by a
specific field (Fig 5.40).

5. Click a field name
displayed in the box,  Click
> button and then click
Next button.

Fig 5.39
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6. In this dialog box choose a field for sorting your data in
report student name as field been choosen (Fig 5.41). Click
next button.

7. Select a layout for the report from the layout group
(Fig 5.42).

Fig 5.41 Fig 5.42

8. Select orientation of the page from orientation group, click
Next button. In the dialog box that appears, choose a style
you want for this report (Fig 5.43).

9. Click next button provide a title for the report and click
Finish button.

Fig 5.43
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The report will open as shown in the Fig 5.44.

Fig 5.44

5.17.3 Creating a Report using Blank Report Tool
Steps for creating this report are as follows:
1. Click create tab, in the report group, click Blank Report

button.
A blank report is opened in Layout view along with the Field List
Pane (Fig 5.45).

Fig 5.45
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2. In the Field List pane, click the plus sign (+) against the
table that contains the fields to be include in the report
(Fig 5.46).

Fig 5.46
To add a field to the report, double-click it. If you want to
add tools in the report like title, page numbers, etc., click
under Format tab and in the controls group, click the tool
which you want.

After adding tool, the report will appear as shown in Fig 5.47.

Fig 5.47
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5.18 SECTIONS OF A REPORT

The design of a report in Access 2007 has following sections (Fig
5.48).

Fig 5.48

 Report Header: It is at the beginning of the report and
contains information that might normally appear on a cover
page, such as a title.

 Page Header: Presented at the top of every page. For
example, fields of the table.

 Group Header: Presented at the beginning of each new
group of records.

 Detail: Presented once for every row in the record source.

 Group footer: Printed at the end of each group of records.

 Page Footer: Printed at the end of every page. Use a page
footer to print page numbers.

 Report Footer: Printed just once at the end of the report.
Use the report footer to print report totals or other summary
information for the complete report.

5.19 PRINT PREVIEW A REPORT

Various steps to print Preview a report are as follows:

1. Click on the MS office button, menu appears. (Fig. 5.49)



148 :: Computer and Office Applications

Fig 5.49

2. Now, point the cursor in Print option
(Fig 5.50), click on Print Preview.

3. Access switches to Print Preview mode.

5.20 PRINTING A REPORT

1. Click on the MS office button, click on the
Print option. A print dialog box appears (Fig
5.51). Provide the desired information before
printing  and click on OK button to print the
report.

Fig 5.51

Fig 5.50


